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Lookup Tables and Logical Functions  .  .  .  .  .  .  .  .  EX 3-28
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Absolute Cell References  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  EX 3-32
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Organizing Data . .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . AC 1-4

Databases and Relationships . .  .  .  .  .  .  .  .  .  .  .  .  . AC 1-4

Relational Database Management Systems . .  .  .  AC 1-6
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Working in Touch Mode  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . AC 1-9

Creating a Table in Datasheet View .  .  .  .  .  .  .  .  .  .  AC 1-11
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Primary Key Field .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  AC 1-13
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Access Database . . . . . . . . . . . . . . . . . . . . . . . . AC 1-34

Navigating a Datasheet .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . AC 1-38

Creating a Simple Query  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . AC 1-39

Creating a Simple Form .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . AC 1-42

Creating a Simple Report .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . AC 1-45

Printing a Report .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . AC 1-48
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Using Microsoft Access Help .  .  .  .  .  .  .  .  .  .  .  .  .  .  . AC 1-49

Managing a Database  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . AC 1-50

Compacting and Repairing a Database  .  .  .  . AC 1-51

Backing Up and Restoring a Database .  .  .  .  . AC 1-52

Session 1.2 Quick Check  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . AC 1-53

Formatting Data Markers  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  EX 4-24

Creating a Combination Chart .  .  .  .  .  .  .  .  .  .  .  .  .  .  EX 4-26

Adding an Axis Title  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  EX 4-28
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Session 4.2 Visual Overview: 

Scatter Charts, Data Bars, and Sparklines .  .  .  .  . EX 4-32

Creating a Scatter Chart . . . . . . . . . . . . . . . . . . EX 4-34

Editing the Chart Data Source .  .  .  .  .  .  .  .  .  .  .  .  .  .  EX 4-37

Adding Graphic Objects to a Workbook .  .  .  .  .  . EX 4-39

Adding a Data Callout to a Chart .  .  .  .  .  .  .  .  . EX 4-40

Inserting a Graphic Shape .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  EX 4-41

Inserting Graphic Icons .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . EX 4-42

Tools for Managing Graphic Objects  .  .  .  .  .  . EX 4-44

Exploring Other Chart Types .  .  .  .  .  .  .  .  .  .  .  .  .  .  . EX 4-45

Hierarchy Charts  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . EX 4-45

Pareto Charts . .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . EX 4-46

Histogram Charts  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . EX 4-46

Waterfall Charts . .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . EX 4-47

Creating Data Bars .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . EX 4-48

Modifying a Data Bar Rule . . . . . . . . . . . . . . EX 4-49

Creating Sparklines . . . . . . . . . . . . . . . . . . . . . . EX 4-50

Formatting a Sparkline  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . EX 4-54

Sparkline Groups and Sparkline Axes .  .  .  .  .  . EX 4-55

Session 4.2 Quick Check  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . EX 4-57

Review Assignments . .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . EX 4-58

Case Problems .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  EX 4-59

ACCESS MODULES

Module 1 Creating a Database
Tracking Patient, Visit, and Billing Data .  .  .  .  AC 1-1

Session 1.1 Visual Overview:  

The Access Window .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . AC 1-2

Introduction to Database Concepts . .  .  .  .  .  .  .  .  .  . AC 1-4
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Setting the Default Value Property  
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Session 2.2 Quick Check  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . AC 2-51

Review Assignments . .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . AC 2-52

Case Problems .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . AC 2-53

Module 3 Maintaining and Querying a Database
Updating and Retrieving Information  
About Patients, Visits, and Invoices .  .  .  .  .  AC 3-1

Session 3.1 Visual Overview:  

Query Window in Design View  .  .  .  .  .  .  .  .  .  .  .  .  .  . AC 3-2

Updating a Database .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . AC 3-4

Modifying Records  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . AC 3-4

Hiding and Unhiding Fields .  .  .  .  .  .  .  .  .  .  .  .  .  .  . AC 3-5

Finding Data in a Table .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . AC 3-7

Deleting Records .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . AC 3-8

Introduction to Queries .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . AC 3-10

Creating and Running a Query . .  .  .  .  .  .  .  .  .  .  .  .  .  AC 3-11

Updating Data Using a Query .  .  .  .  .  .  .  .  .  .  .  .  .  .  AC 3-14

Creating a Multitable Query  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . AC 3-15

Sorting Data in a Query .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  AC 3-17

Using an AutoFilter to Sort Data .  .  .  .  .  .  .  .  .  .  AC 3-17

Sorting on Multiple Fields in Design View  .  . AC 3-18

Filtering Data  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . AC 3-22

Session 3.1 Quick Check . .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . AC 3-25

Session 3.2 Visual Overview:  

Selection Criteria in Queries  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . AC 3-26

Review Assignments . .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . AC 1-54

Case Problems .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . AC 1-55

Module 2 Building a Database and Defining  
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Guidelines for Designing Databases  .  .  .  .  .  .  .  .  .  . AC 2-4

Guidelines for Setting Field Properties .  .  .  .  .  .  .  . AC 2-6

Naming Fields and Objects . .  .  .  .  .  .  .  .  .  .  .  .  .  . AC 2-6

Assigning Field Data Types .  .  .  .  .  .  .  .  .  .  .  .  .  .  . AC 2-6

Setting Field Sizes .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . AC 2-7

Setting the Caption Property for Fields .  .  .  .  . AC 2-8

Modifying a Table in Design View .  .  .  .  .  .  .  .  .  .  .  . AC 2-9

Saving the Table Structure  .  .  .  .  .  .  .  .  .  .  .  .  .  .  AC 2-15

Modifying the Structure of an Access Table  .  .  .  AC 2-16

Moving a Field in Design View  .  .  .  .  .  .  .  .  .  .  .  AC 2-16

Adding a Field in Design View  .  .  .  .  .  .  .  .  .  .  .  AC 2-17

Modifying Field Properties . .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  AC 2-18

Changing the Format Property  

in Datasheet View .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  AC 2-18

Changing Properties in Design View . .  .  .  .  .  . AC 2-20

Session 2.1 Quick Check . .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . AC 2-23

Session 2.2 Visual Overview:  

Understanding Table Relationships .  .  .  .  .  .  .  .  .  . AC 2-24

Adding Records to a New Table  .  .  .  .  .  .  .  .  .  .  .  . AC 2-26

Importing Data from an Excel Worksheet .  .  .  .  . AC 2-28

Creating a Table by Importing an Existing  

Table or Table Structure .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . AC 2-32

Adding Fields to a Table Using the Data  

Type Gallery .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . AC 2-34

Modifying the Structure of an Imported Table .  .  .  AC 2-36

Deleting Fields from a Table Structure .  .  .  .  . AC 2-36

Renaming Fields in Design View .  .  .  .  .  .  .  .  .  . AC 2-38
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Navigating a Form .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . AC 4-15

Finding Data Using a Form . .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . AC 4-16
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Previewing and Printing Selected  

Form Records .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . AC 4-20

Creating a Form with a Main Form  

and a Subform  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . AC 4-22

Session 4.1 Quick Check . .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . AC 4-27

Session 4.2 Visual Overview:  

Report Displayed in Print Preview .  .  .  .  .  .  .  .  .  .  . AC 4-28

Creating a Report Using the Report Wizard  .  .  . AC 4-30

Modifying a Report’s Design in Layout View .  .  . AC 4-34
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Changing the Alignment of Field Values . .  .  . AC 4-35
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Using Conditional Formatting in a Report .  .  .  .  . AC 4-39

Session 4.2 Quick Check  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . AC 4-43
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POWERPOINT MODULES

Module 1 Creating a Presentation
Presenting Information About  
an Insurance Company .  .  .  .  .  .  .  .  .  .  .  .  .  . PPT 1-1

Session 1.1 Visual Overview:  

The PowerPoint Window  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  PPT 1-2

Planning a Presentation .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  PPT 1-4

Starting PowerPoint and Creating  

a New Presentation  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  PPT 1-5

Working in Touch Mode  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  PPT 1-6

Creating a Title Slide  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  PPT 1-8

Saving and Editing a Presentation .  .  .  .  .  .  .  .  .  .  .  PPT 1-9

Adding New Slides .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  PPT 1-12
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Specifying an Exact Match  .  .  .  .  .  .  .  .  .  .  .  .  .  . AC 3-28

Modifying a Query  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . AC 3-30
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Changing a Datasheet’s Appearance . .  .  .  .  .  .  .  . AC 3-40

Modifying the Font Size  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . AC 3-40
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Creating a Calculated Field .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . AC 3-42

Formatting a Calculated Field .  .  .  .  .  .  .  .  .  .  .  . AC 3-46

Using Aggregate Functions .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . AC 3-47
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Using the Total Row . .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . AC 3-48
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Getting to Know Microsoft Office Versions  OFF-1

Getting to Know  
Microsoft Office Versions 
Cengage is proud to bring you the next edition of Microsoft Office. This 
edition was designed to provide a robust learning experience that is not 
dependent upon a specific version of Office.

Microsoft supports several versions of Office: 

•	Office 365: A cloud-based subscription service that delivers 
Microsoft’s most up-to-date, feature-rich, modern productivity tools 
direct to your device. There are variations of Office 365 for business, 
educational, and personal use. Office 365 offers extra online storage 
and cloud-connected features, as well as updates with the latest 
features, fixes, and security updates.

•	Office 2019: Microsoft’s “on-premises” version of the Office apps, 
available for both PCs and Macs, offered as a static, one-time 
purchase and outside of the subscription model. 

•	Office Online: A free, simplified version of Office web applications 
(Word, Excel, PowerPoint, and OneNote) that facilitates creating and 
editing files collaboratively. 

Office 365 (the subscription model) and Office 2019 (the one-time pur-
chase model) had only slight differences between them at the time this 
content was developed. Over time, Office 365’s cloud interface will con-
tinuously update, offering new application features and functions, while 
Office 2019 will remain static. Therefore, your onscreen experience may 
differ from what you see in this product. For example, the more advanced 
features and functionalities covered in this product may not be available 
in Office Online or may have updated from what you see in Office 2019. 

For more information on the differences between Office 365, Office 2019, 
and Office Online, please visit the Microsoft Support site. 

Cengage is committed to providing high-quality learning solutions for 
you to gain the knowledge and skills that will empower you throughout 
your educational and professional careers.

Thank you for using our product, and we look forward to exploring the 
future of Microsoft Office with you! 
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Using SAM Projects and Textbook Projects  SAM-1

Using SAM Projects  
and Textbook Projects
SAM and MindTap are interactive online platforms designed to transform 
students into Microsoft Office and Computer Concepts masters. Practice 
with simulated SAM Trainings and MindTap activities and actively apply 
the skills you learned live in Microsoft Word, Excel, PowerPoint, or Access. 
Become a more productive student and use these skills throughout 
your career.

If your instructor assigns SAM Projects:

	 1.	 Launch your SAM Project assignment from SAM or MindTap.

	 2.	 Click the links to download your Instructions file, Start file, and 
Support files (when available).

	 3.	 Open the Instructions file and follow the step-by-step instructions.

	 4.	 When you complete the project, upload your file to SAM or MindTap 
for immediate feedback. 

To use SAM Textbook Projects:

	 1.	 Launch your SAM Project assignment from SAM or MindTap.

	 2.	 Click the links to download your Start file and Support files 
(when available).

	 3.	 Locate the module indicated in your book or eBook.

	 4.	 Read the module and complete the project. 

IMPORTANT: To receive full credit for your Textbook Project, you must 
complete the activity using the Start file you downloaded from SAM 
or MindTap.

	 Open the Start file you downloaded.

	� Save, close, and upload your completed project to receive  
immediate feedback.
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WD 1–1

MODULE 1
OBJECTIVES

Session 1.1
•	Create and save a document
•	Enter text and correct errors as 

you type
•	Use AutoComplete and 

AutoCorrect
•	Select text and move the 

insertion point
•	Undo and redo actions
•	Adjust paragraph spacing, line 

spacing, and margins
•	Preview and print a document
•	Create an envelope

Session 1.2
•	Open an existing document
•	Use the Editor pane
•	Change page orientation, font, 

font color, and font size
•	Apply text effects and align text
•	Copy formatting with the 

Format Painter
•	Insert a paragraph border and 

shading
•	Delete, insert, and edit a photo
•	Add a page border
•	Create bulleted and numbered 

lists
•	Use Microsoft Word Help

Creating and 
Editing a 
Document
Writing a Business Letter and 
Formatting a Flyer

Case | Water Resources Department
David Alzacar is the communications director for the Water 
Resources Department in Portland, Oregon. As part of his outreach 
efforts, he has produced a set of brochures promoting the city’s 
water conservation efforts. David has asked you to create a cover 
letter to accompany the brochures he is sending to the organizers 
of a national sustainability conference. He has also asked you 
to create an envelope for sending a water quality report to an 
environmental engineering publication. Next, he wants your 
help creating a flyer encouraging community members to join a 
citizen advisory panel. Finally, he would like to add bulleted and 
numbered lists to the minutes of a recent advisory panel meeting.

You will create the letter and flyer using Microsoft Office Word 2019 
(or simply Word), a full-featured word processing app that lets you 
create professional-looking documents and revise them easily. You’ll 
start by opening Word and saving a new document. Then you’ll type 
the text of the cover letter and print it. In the process of entering the 
text, you’ll learn several ways to correct typing errors and how to adjust 
paragraph and line spacing. When you create the envelope, you’ll 
learn how to save it as part of a document for later use. As you work 
on the flyer, you will learn how to open an existing document, change 
the way text is laid out on the page, format text, add a page border, and 
insert and resize a photo. Finally, you’ll add bulleted and numbered 
lists to a document, and then learn how to use Microsoft Word Help.

STARTING DATA FILES

Word1 Module

NP_WD_1-1.docx
NP_WD_1-2.docx
Support_WD_1_Water.png

Review

NP_WD_1-3.docx
NP_WD_1-4.docx
Support_WD_1_Glass.png

Case1

(none)

Case2

NP_WD_1-5.docx
Support_WD_1_Sign.jpg
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Word | Module 1 Creating and Editing a DocumentWD 1–2

Session 1.1 Visual Overview: 

You can choose to display the
rulers, which help you position
elements in a document.

Buttons for related commands
are organized on a tab in
groups. The buttons in this
group can be used to change
the appearance of a paragraph.

The status bar provides
information about the
current document, such as
the current page and
number of words in the
document; it also contains
buttons and other
controls for working with
the document.

The paragraph mark indicates the end
of a paragraph. It is visible only if
nonprinting characters are turned on.
Nonprinting characters appear on the
screen but not on the printed page.

The insertion point shows
where characters will appear
when you start typing.

The ribbon is the main set of
buttons and other tools you
can use to complete tasks.
It is organized into tabs and
groups.

The Quick Access Toolbar is
a collection of buttons that
provides one-click access to
commonly used commands,
such as Save, Undo, and
Repeat; you might see
additional buttons here.

Each tab includes commands related
to particular activities or tasks. The
Home tab includes options for
formatting and editing text.

The title bar displays
the name of the open
file and the program.

The dark gray areas on the ruler 
represent the document’s margins. 
Margins are the blank spaces around 
the edges of a document’s content.
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Module 1 Creating and Editing a Document | Word WD 1–3

The Word Window
The Show/Hide button is
selected, meaning that
nonprinting characters are
displayed in the document.

You can click the Ribbon Display Options button
to display a menu with options for how the
ribbon looks. If the ribbon is hidden, click Show
Tabs and Commands in this menu to redisplay it.

You use the Minimize button
to reduce the Word window
to an icon in the taskbar,
which you can click later to
display the Word window
again.

You use the Restore Down
button to reduce the Word
window to a smaller size; the
Restore Down button is then
replaced with the Maximize
button, which you can click
to restore the Word window
to its full size.

You can click the scroll
arrows to scroll up or down
one line, or hold the mouse
button to scroll up or down
more quickly.

If you are signed in, your
name appears here as a
link that you can click to
access information about
your Microsoft account.

You can drag the scroll box 
up or down to see other 
parts of a document.

Zooming magnifies or shrinks
the display of the content in
the Word window. To quickly
change the Zoom level, drag
the slider button left or right
on the Zoom slider.

The View buttons allow
you to change the way the
document is displayed.Print Layout view, the default

view, most closely resembles
how your document will look
when printed.
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Word | Module 1 Creating and Editing a DocumentWD 1–4

Starting Word
With Word, you can quickly create polished, professional documents. You can type a 
document, adjust margins and spacing, create columns and tables, add graphics, and 
then easily make revisions and corrections. In this session, you will create one of the 
most common types of documents—a block-style business letter.

To begin creating the letter, you first need to start Microsoft Word and then set up the 
Word window.

To start Word:
◗	 1.	  On the Windows taskbar, click the Start button  . The Start menu 

opens.

◗	 2.	 On the Start menu, scroll the list of apps, and then click Word. Word starts 
and displays the Recent screen in Backstage view. Backstage view provides 
access to various screens with commands that allow you to manage files and 
Word options. See Figure 1–1.

◗	 3.	 Click Blank document. The Word window opens, with the ribbon displayed. 

Trouble?  If you don’t see the ribbon, click the Ribbon Display Options 
button  , as shown in the Session 1.1 Visual Overview, and then click Show 
Tabs and Commands.

Don’t be concerned if your Word window doesn’t match the Session 1.1 
Visual Overview exactly. You’ll have a chance to adjust its appearance 
shortly.

Figure 1–1	 Recent screen in Backstage view

click to open a new,
blank document

a list of recently
opened documents
might appear here

your list of available
templates may differ
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Module 1 Creating and Editing a Document | Word WD 1–5

Working in Touch Mode
You can interact with the Word screen using a mouse, or, if you have a touchscreen, 
you can work in Touch Mode, using a finger instead of the pointer. In Touch Mode, 
extra space around the buttons on the ribbon makes it easier to tap the specific 
button you need. The figures in this text show the screen with Mouse Mode on, 
but it’s helpful to learn how to switch back and forth between Touch Mode and 
Mouse Mode.

Note: The steps in this module assume that you are using a mouse. If you are instead 
using a touch device, please read these steps but don’t complete them so that you 
remain working in Touch Mode.

To switch between Touch and Mouse Mode:
◗	 1.	 On the Quick Access Toolbar, click the Customize Quick Access Toolbar 

button  to open the menu. The Touch/Mouse Mode command near the 
bottom of the menu does not have a checkmark next to it, indicating that it 
is currently not selected.

Trouble?  If the Touch/Mouse Mode command has a checkmark next to it, 
press ESC to close the menu, and then skip to Step 3.

◗	 2.	 On the menu, click Touch/Mouse Mode. The menu closes, and the  
Touch/Mouse Mode button  appears on the Quick Access Toolbar.

◗	 3.	 On the Quick Access Toolbar, click the Touch/Mouse Mode button  . 
A menu opens with two options—Mouse and Touch. The icon next to Mouse 
is shaded gray to indicate it is selected.

Trouble?  If the icon next to Touch is shaded gray, press ESC to close the 
menu and skip to Step 5.

◗	 4.	 On the menu, click Touch. The menu closes, and the ribbon increases in 
height so that there is more space around each button on the ribbon. See 
Figure 1–2.

Trouble?  If you are working with a touchscreen and want to use Touch 
Mode, skip Steps 5 and 6.

◗	 5.	 On the Quick Access Toolbar, click the Touch/Mouse Mode button  , and 
then click Mouse. The ribbon changes back to its Mouse Mode appearance, 
as shown in the Session 1.1 Visual Overview.

Figure 1–2	 Word window in Touch Mode 

insertion point

Touch/Mouse Mode
button

Customize Quick
Access Toolbar button

expanded ribbon, with
buttons farther apart
than in Mouse Mode
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Word | Module 1 Creating and Editing a DocumentWD 1–6

To set up your Word window to match the figures in this book:
◗	 1.	 If the Word window does not fill the entire screen, click the Maximize button 

 in the upper-right corner of the Word window.

The insertion point on your computer should be positioned about an inch 
from the top of the document, as shown in Figure 1–2, with the top margin 
visible.

Trouble?  If the insertion point appears at the top of the document, with no 
white space above it, position the pointer between the top of the document 
and the horizontal ruler, until it changes to  , double-click, and then scroll 
up to top of the document.

◗	 2.	 On the ribbon, click the View tab. The ribbon changes to show options for 
changing the appearance of the Word window.

◗	 3.	 In the Show group, click the Ruler check box to insert a checkmark, if 
necessary. If the rulers were not displayed, they are displayed now.

Next, you’ll change the Zoom level to a setting that ensures that your Word 
window will match the figures in this book. To increase or decrease the 
screen’s magnification, you could drag the slider button on the Zoom slider 
in the lower-right corner of the Word window. But to choose a specific Zoom 
level, it’s easier to use the Zoom dialog box.

◗	 4.	 In the Zoom group, click the Zoom button to open the Zoom dialog box. 
Double-click the current value in the Percent box to select it, type 120, and 
then click OK to close the Zoom dialog box.

◗	 5.	 On the status bar, click the Print Layout button  to select it, if necessary. 
As shown in the Session 1.1 Visual Overview, the Print Layout button is the 
middle of the three View buttons located on the right side of the status 
bar. The Print Layout button in the Views group on the View tab is also 
now selected.

Changing the Zoom level 
affects only the way the 
document is displayed 
on the screen; it does not 
affect the document itself.

Before typing a document, you should make sure nonprinting characters are 
displayed. Nonprinting characters provide a visual representation of details you might 
otherwise miss. For example, the (¶) character marks the end of a paragraph, and the 
(•) character marks the space between words.

◗	 6.	 On the Quick Access Toolbar, click the Customize Quick Access Toolbar 
button  , and then click Touch/Mouse Mode to deselect it. The  
Touch/Mouse Mode button is removed from the Quick Access Toolbar.

Setting Up the Word Window
Before you start using Word, you should make sure you can locate and identify 
the different elements of the Word window, as shown in the Session 1.1 Visual 
Overview. In the following steps, you’ll make sure your screen matches the Visual 
Overview.
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Saving a Document
Before you begin working on a document, you should save it with a new name. When 
you use the Save button on the Quick Access Toolbar to save a document for the first 
time, Word displays the Save As screen in Backstage view. In the Save As screen, you 
can select the location where you want to store your document. After that, when you 
click the Save button, Word saves your document to the same location you specified 
earlier and with the same name.

To save the document:
◗	 1.	 On the Quick Access Toolbar, click the Save button  . Word switches to the 

Save As screen in Backstage view, as shown in Figure 1–3.

Because a document is now open, more commands are available in 
Backstage view than when you started Word. The navigation pane on 
the left contains commands for working with the open document and for 
changing settings that control how Word works.

◗	 2.	 Click the Browse button. The Save As dialog box opens.

To verify that nonprinting characters are displayed:
◗	 1.	 On the ribbon, click the Home tab.

◗	 2.	 In the blank Word document, look for the paragraph mark (¶) in the first line 
of the document, just to the right of the blinking insertion point.

Trouble?  If you don’t see the paragraph mark, click the Show/Hide ¶ button
 in the Paragraph group.

In the Paragraph group, the Show/Hide ¶ button should be highlighted in 
gray, indicating that it is selected, and the paragraph mark (¶) should appear 
in the first line of the document, just to the right of the insertion point.

Figure 1–3	 Save As screen in Backstage view

navigation pane

Save As
selected in the
navigation pane

click to open the
Save As dialog
box

you might see additional folders here; if you want to save
a document in a folder that is listed here, click the folder
to open the Save As dialog box with that folder selected

click to return to
the document
window
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◗	 4.	 Click the File name box, and then type NP_WD_1_Letter. The text you type 
replaces the selected text in the File name box.

◗	 5.	 Click Save. The file is saved, the dialog box and Backstage view close, and 
the document window appears again, with the new file name in the title bar. 

Now that you have saved the document, you can begin typing the letter. David has 
asked you to type a block-style letter to accompany some water conservation brochures 
that will be sent to Carla Zimmerman. Figure 1–5 shows the block-style letter you will 
create in this module.

Trouble?  If your instructor wants you to save your files to your OneDrive 
account, click OneDrive, and then log in to your account.

◗	 3.	 Navigate to the location specified by your instructor. The default file name, 
“Doc1,” appears in the File name box. You will change that to something 
more descriptive. See Figure 1–4.

Figure 1–4	 Save As dialog box

default filename

you might see
something different
here, depending
on the location
specified by your
instructor
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Figure 1–5	 Completed block-style letter

Water Resources Department

9088 Woodhouse Avenue

Portland, Oregon 97204

www.water.portland.cengage.com
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inside address

complimentary close

signature and 
title lines

typist’s initials

salutation

date

body

indicates the letter 
has something 
accompanying it

entire letter aligned 
along left margin
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Written Communication: Creating a Business Letter

Several styles are considered acceptable for business letters. The main differences 
among the styles have to do with how parts of the letter are indented from the left 
margin. In the block style, which you will use in this module, each line of text starts at 
the left margin. In other words, nothing is indented. Another style is to indent the first 
line of each paragraph. The choice of style is largely a matter of personal preference, 
or it can be determined by the standards used in a particular business or organization. 
To further enhance your skills in writing business correspondence, you should consult 
an authoritative book on business writing that provides guidelines for creating a 
variety of business documents, such as Business Communication: Process & Product, 
by Mary Ellen Guffey and Dana Loewy.
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To insert the date:
◗	 1.	 Type Febr (the first four letters of “February”). A ScreenTip appears above the 

letters, as shown in Figure 1–6, suggesting “February” as the complete word.

A ScreenTip is a label with descriptive text or an explanation about what to 
do next.

If you wanted to type something other than “February,” you could 
continue typing to complete the word. In this case, you want to accept the 
AutoComplete suggestion.

◗	 2.	 Press ENTER. The rest of the word “February” is inserted in the document. Note 
that AutoComplete works for long month names like February but not shorter ones 
like May, because “Ma” could be the beginning of many words besides “May.”

◗	 3.	 Press SPACEBAR, type 1, 2021 and then press ENTER twice, leaving a blank 
paragraph between the date and the line where you will begin typing the 
inside address, which contains the recipient’s name and address. Notice the 
nonprinting character (•) after the word “February” and before the number 
“1,” which indicates a space. Word inserts this nonprinting character every 
time you press SPACEBAR.

Trouble?  If February happens to be the current month, you will see a 
second AutoComplete suggestion displaying the current date after you press 
SPACEBAR. To ignore that AutoComplete suggestion, continue typing the 
rest of the date, as instructed in Step 3.

Entering Text
The letters you type in a Word document appear at the current location of the blinking 
insertion point.

Inserting a Date with AutoComplete
The first item in a block-style business letter is the date. David plans to send the letter 
to Carla on February 1, so you need to insert that date into the document. To do so, you 
can take advantage of AutoComplete, a Word feature that automatically suggests dates 
and other regularly used items for you to insert. In this case, you can type the first few 
characters of the month and let Word insert the rest.

Figure 1–6	 AutoComplete suggestion

ScreenTip tells you
how to enter the rest
of the word “February”
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To insert the inside address:
◗	 1.	 Type the following information, pressing ENTER after each item:

Carla Zimmerman

Association of Water Quality Engineers

2800 Eagle View Road

Pittsburgh, PA 15222

Remember to press ENTER after you type the zip code. Your screen should 
look like Figure 1–7. Don’t be concerned if the lines of the inside address 
seem too far apart. You’ll use the default spacing for now, and then adjust it 
after you finish typing the letter. 

Note that you can also insert the current date (as well as the current time) by using 
the Insert Date and Time button in the Text group on the Insert tab. This opens the Date 
and Time dialog box, where you can select from a variety of date and time formats. If 
you want Word to update the date or time automatically each time you re-open the 
document, select the Update automatically check box. In that case, Word inserts the 
date and time as a special element called a field, which you’ll learn more about as you 
become a more experienced Word user. However, for typical correspondence, it makes 
more sense to deselect the Update automatically check box so the date and time are 
inserted in the document as ordinary text.

Continuing to Type the Block-Style Letter
In a block-style business letter, the inside address appears below the date, with one 
blank paragraph in between. Some style guides recommend including even more space 
between the date and the inside address. But in the short letter you are typing, more 
space would make the document look out of balance.

Figure 1–7	 Letter with inside address

blank paragraph
between the
date and the
inside address

insertion point

Trouble?  If you make a mistake while typing, press BACKSPACE to delete 
the incorrect character, and then type the correct character. 
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The next sentence you need to type includes David’s email address.

Typing a Hyperlink
When you type an email address and then press the SPACEBAR or ENTER, Word 
converts it to a hyperlink, with blue font and an underline. A hyperlink is a specially 
formatted word, phrase, or graphic which, when clicked or tapped, lets you display a 
webpage on the Internet, another file, an email, or another location within the same 
file; it is sometimes called hypertext or a link. Hyperlinks are useful in documents that 
you plan to distribute via email. In printed documents, where blue font and underlines 
can be distracting, you’ll usually want to convert a hyperlink back to regular text.

To type the salutation and the body of the letter:
◗	 1.	 Type Dear Carla: and then press ENTER to start a new paragraph for the 

body of the letter.

◗	 2.	 Type the following sentence, including the period: Enclosed you will find 
the sustainability brochures we discussed. 

◗	 3.	 Press SPACEBAR. Note that you should only include one space between 
sentences.

◗	 4.	 Type the following sentence, including the period: Thank you for agreeing 
to distribute them at next month’s National Water Quality Conference.

◗	 5.	 On the Quick Access Toolbar, click the Save button  . Word saves the 
document as NP_WD_1_Letter to the same location you specified earlier.

The obsolete practice of 
pressing SPACEBAR twice 
at the end of a sentence 
dates back to the age 
of typewriters, when 
the extra space made it 
easier to see where one 
sentence ended and 
another began.

To add a sentence containing an email address:
◗	 1.	 Press SPACEBAR, and then type the following sentence, 

including the period: If you have any questions not covered in the 
brochures, please contact me at water@portland.cengage.com.

◗	 2.	 Press ENTER. Word converts the email address to a hyperlink, with blue font 
and an underline. The same thing would happen if you pressed SPACEBAR 
instead of ENTER.

◗	 3.	 Position the pointer over the hyperlink. A ScreenTip appears, indicating that 
you could press and hold CTRL and then click the link to follow it—that is, to 
open an email message addressed to the Water Resources Department.

◗	 4.	 With the pointer positioned over the hyperlink, right-click—that is, press 
the right mouse button. A shortcut menu opens with commands related to 
working with hyperlinks.

You can right-click many items in the Word window to display a shortcut 
menu with commands related to the item you right-clicked. The Mini toolbar 
also appears when you right-click or select text, giving you easy access to the 
buttons and settings most often used when formatting text. See Figure 1–8. 

Now you can move on to the salutation and the body of the letter. As you type the 
body of the letter, notice that Word automatically moves the insertion point to a new 
line when the current line is full.
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